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Format Conventions
In this document the following format conventions are used:

Commands that you must type in are shown W N31
in bol dOCouri er font.
Menu items are given in a Bold, Arial font. Windows Applications
Keys that you press are enclosed in angle <Enter>
brackets.
Feedback

If you notice any mistakes in this document please contact the Information Officer.
Email should be sent to the address i nf o-of fi cer @ eeds. ac. uk

Copyright

This document is copyright University of Leeds. Permission to use material in this
document should be obtained from the Information Officer (email should be sent to
the address i nf o- of fi cer @ eeds. ac. uk)

Print Record

This document was printed on 16-Jun-03.



Task 1 Launching Internet Explorer

Objective To run Internet Explorer (IE).
Instructions You will run Microsoft Windows and then launch IE..

Comments You will need to have a username and password for a Novell file
server.

Activity 1.1 Login to PC in an ISS cluster. The Windows desktop is displayed.

Activity 1.2 Double-click on the Internet Explorer icon. After a short wait, the IE
screen is displayed as shown below.
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Task 2 Using Internet Explorer

To use IE to access University Library information.

Objective
Instructions

Comments

You will click on the University Library link in the University Pages.

The University Library provides a wide range of information on the

World Wide Web.

Activity 2.1

Activity 2.2

Activity 2.3

Click on the option
Academi c[0Ser vi ces on
the left of the IE screen.
Next click on Li brary.

A new window displaying
a screen similar to the
one shown opposite
opens.

The document URL
(Uniform Resource
Locator) is displayed near
the top of the screen, in
the Address: window.

Look at the docume
URL. Notice that it
contains the address

| eeds. ac. uk This
indicates that the
document is held on a
computer system at
Leeds University, which
is in the UK academic
community.

The document URL is a
little like a postcode, in
that it provides a precise

2} Leeds University Library - Microsoft Internet Explorer provided by IS
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The University Library home page (August 2002)

reference to the location of a document.

In order to look at material on the WWW you will need to know how to
retrieve a document. All documents on the WWW can be retrieved
using the document URL. A URL can be typed into the Address:
window shown above. To type a URL into the Address:[window
simply click your mouse inside it and start typing. Pressing the
<Enter> key on your keyboard will then load the document.

Notice the underlined text on screen. This underlined text is usually
a hypertext link. Clicking on a hypertext link will activate the retrieval
of a new document. Move the cursor over the hypertext links, and
notice how it changes into a hand icon when it moves over a link.
Notice also how the destination of the link is displayed near the

bottom of the window.



Task 3 Using The World Wide Web

Objective To retrieve documents held on the World Wide Web (which is often
referred to as W3 or WWW).

Instructions To retrieve documents held on the World Wide Web using IE you
simply need to click on the highlighted options.

Comments World Wide Web documents are normally stored in a format known as
HTML (hyper t ext Ovar kupd anguage). HTML documents can be
converted from other file formats. In addition other file formats, such
as colour photographs, can be displayed.

Activity 3.1 Click on the tab to Electronic Resources.

Activity 3.2 Now click on the External web links hyper-link.

“}1 You are here: Library = Electronic resol
I 9 eres
Y &

EAQ

Electronic
resources

Library Library
home catalogue

Using the Openi
Libra how

Datahases | Electronic journals | External weh links |

Activity 3.3 Take a look at this page. It contains to links other sources of
information on the WWW. Many of these are useful for academic
purposes.

The page is broken down into different categories — these include
general resources, subject listings of resources and a search option.

Browse external web links by subject Top of page 4

s General

e Search engines
e Subject indexes and gateways

o Arts resources

s Biological sciences

s Business, law, education and social sciences

e Earth and environment

* Engineering

s Mathermatics and physical sciences

o Medicine, dentistry, psychology and health w

Use the scroll bar on the right of the screen to move up and down the screen in
order to view the full page.



Activity 3.4 Have a look at the section with the heading Gener al .

Activity 3.5 When you have finished looking at the this section you can move
back to the Selected web sites page by clicking on the <Back> _
button in the toolbar (or choose the Back option from the Go To O Back
sub-menu, under the View menu) .



Task 4 Browsing the WWW

Objective To view documents held on computer systems linked to the WWW.

Instructions Access to a number of documents can be obtained using some of the
tools available from the External web links page.

Activity 4.1 Select the link to Subject Indexes and Gateways from the External web
links page. This leads to a subject list for subject indexes and
information gateways on the World Wide Web.

Choose the link BUBL LINK (you may have to scroll down the page to
see this link). BUBL is a subject guide to resources on the Internet,
based at the University of Bath. BUBL stands for Bulletin Board for
Libraries - although the service covers a much wider area than simply
library information.

When the BUBL page has loaded, use the scroll bar on the right of the
screen to move down this page and take a look at the different subject
areas which are available. Choose an area and if you then find a
subject which interests you, you can take a look at the resources
listed in that section by clicking on the hypertext links.

When you have explored the BUBL service return to the Subject
Indexes and Information Gateways page by clicking on the <Back>
button on the IE toolbar.

Activity 4.2 Another service which can be useful when trying to locate resources
on the WWW is the NISS Information Gateway. NISS (National
Information Services and Systems) is a service which promotes access
to electronic information for the UK Higher Education community.

Access NISS by scrolling down the current page and clicking on the
button next to NISS Directory of Networked Resources. The NISS
directory of resources will load. Choose the A/Z link and then scroll
down this list and have a look at the different subject areas which are
available.

Activity 4.3 When you have finished exploring the NISS Information Gateway you
should move back to the External web links page using the <Back>
button on the IE toolbar.



Task 5 Searching the WWW

Objective To search the World Wide Web.

Instructions You will be taken through a series of logical steps which will
introduce you to searching the WWW.

Comments A number of searching tools are available from Library pages.

Activity 5.1 Select the link called Search Engines on the External web links page.
This section contains links to some tools which you can use to search
for information on the WWW.

Search engines can be used to search through databases of
documents on the WWW and the Internet. They work by providing an
empty box or form on screen into which search words can be typed.
The search engine will then perform a rapid search through its
database and retrieve documents which contain the word(s) you have
specified.

Activity 5.2 Access the Alta Vista search engine by scrolling down and clicking on
the Alta Vista link. Alta Vista is an extremely powerful tool which has
a large database of WWW resources.

CLICK HERE TO CHECK ON

alta\”Sta HOUSE PRICES, SCHOOLS AND

COMMUNITIES AROUND THE UK.

Home Advanced Search |mages MP3Audio Video Clips Web Directory Mews Search Centres

Find Results: © LK ™ ‘worldwide

Hew! Altavista Prisma: A better way to search More Info

Search Tools Search Centres Marketplace

Family Filter is off Auctions  Betting Business Dating Adultzone Flight, ¢

Customise Finance Insurance Jobs Mahile Low price hosting Advertis

Translate Motoring  Property Shopping Travel Fishing Tackle Save Great i
EEE's

Fower Browser

Click in the search box on the search form to place your cursor inside
it. You can now type a search word. Type the word Leeds[

To start the search click on the <Search> button on screen.

Alta Vista will now perform a search through its database for
documents that contain the word Leeds.

When the search is completed your search results will appear on the
screen. You can now take a look at the documents Alta Vista has
found by clicking on the hypertext links.

Activity 5.3 To find out more about how you can use Alta Vista to search the
WWW, click on the Help link (in the Search Tools list).



Task 6 Saving and Printing Files from the WWW

Objective To save and print a document from the WWW

Instructions You will be taken through a series of logical steps which will
introduce you to saving and printing files from the WWW.

Activity 6.1 If you find some useful information on the WWW it’s likely that you’ll
want to take away a copy for further reference

Activity 6.2 To save a document from the WWW choose the Save As... option from
the File menu. A pop-up window will appear on screen, as shown
below.

Save Web Page

Savein: | I TEMP w . * v -

Y [Lrio0alen

i_-‘ﬁ I)temp_files
My Recent @j ikl
Documerts féj CLUSTER MAME. bk
&) hdloc.html
$Ej Horse guery,html
féj person roles, html
féj gq.kxt, html
. féj Report Cukput.htm
.1)5; ij Rider .html

3 féj roles.hkml

My Computer :
Y P templ. html

Desktop

. féjtemp.html
‘} -@j tesk. html
.
by Metwork,
Places
File narme: hd

Save as type: “Web Page, complete [*.htm;* html) “

Encoding: ‘\Western European (150) hd

Choose the directory you wish to save the file in using the downward
arrow next to the Save in: option.

Leave the Save as type: as Web Page.
Click on the <Save> button to save the file.

Activity 6.3 To print a document from the WWW click on the Print button in
the IE toolbar or choose Print... from the File menu. i

L

If you are printing in a computer cluster you will need to make
sure you have some printer credits available, and that you have the
correct printer selected. Click on the <OK> button in the Print[d
window to print your document.



Task 7 Favourites

Objective To add a URL to your Favorites list.

Instructions You will a new page to your Favorites list and view the current list.

Activity 7.1 Most web browsers have a feature known as ‘bookmarks’ which lets
you create your own file of useful URLs so that you can easily find
these documents again if you need to use them in the future. In
Internet Explorer these are also know as ‘Favorites’. When you find a
useful resource you can automatically add it to your favourites list,
and whenever you use the WWW in the future you can get back to
that resource simply by selecting it from your favourites list.

Activity 7.2 To add a page to your list of favourites, choose Add to Favorites...
from the Favorites menu.

=PI =E Tools  Help
Add to Favorites. ..

Organize Favaorites. ..

The name of the WWW document which you are currently viewing will
now be added to your favourites file. To check this, click on the
Favorites(lmenu again. You will see that a document name has been
added to the list. If you select this item the file will automatically
load.

Alternatively click on the Favorites button on your IE toolbar.
Your list of favourites will be displayed on the left-hand side

i
. = 7 Favorites
of your browser window. W
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Task 8 The History List

Objective To view the list of pages you have visited recently

Instructions You will a view the History list and go back to a page you have already
visited using the list.

Activity 8.1 Internet Explorer automatically keep a list of all the sites you have
visited and saves it in the History file. You can change the number of
days the history file spans by clicking on the Internet Options item in
the Tools menu.

IE toolbar. This history list appears on the left-hand side

Activity 8.2 To view the history file, click on the history button in the }
Qd.'
of the browser window. ==

Activity 8.3 As you move your cursor over the pages in the history
list, notice that they turn blue and become underlined - indicating
that they are links. Some of the links may have folder icons next to
them e.g. campus.leeds. Click on the folder icon to expand the section
to show all the pages in this section.
Hiskory X

YWiew - @ Search

[E] 3 weeks ago
[E7] Last week,

[E] Today

2 campus.leeds (campus leeds, ac, uk)

:E'j Campusweb home page - University of Leeds
& Campusweb
& Campusweb

Folder icon
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